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NEW QUESTION 1
- (Topic 3)
A user is complaining that they are seeing a blank page, when they click Create New, from your custom Inventory application. You have confirmed that they can
see the Inventory application, and the Create New module on the application navigator. What could be the cause of this issue?

A. Create New module has a broken link
B. Known intermittent issue with U115
C. User should be using Chrome instead of Explorer for their browser
D. User has read role, but not the write role on the Inventory table
E. User session has timed out

Answer: D

NEW QUESTION 2
- (Topic 3)
Which feature helps to automatically allocate a critical, high priority, service request to the appropriate assignment group or team member?

A. User Policy
B. UI policy
C. Predictive Intelligence
D. Assignment Rule

Answer: D

NEW QUESTION 3
- (Topic 3)

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table
B. The Form Context menu > Configure > Table
C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 4
- (Topic 3)
In Flow Designer, where is the data from an action stored so it can be used in subsequent actions in the flow?

A. Field Icon
B. Field Value
C. Data Pill
D. Data Element
E. Data Trigger
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Answer: D

NEW QUESTION 5
- (Topic 3)
What are the three key tables in an enterprise CMDO? Choose 3 angwers

A. sn_cmdt_bak
B. Sh_emdb_ci
C. cmap_ret_ci
D. cmdb_bak
E. cmdb_ci
F. sh_eomdb
G. cmap

Answer: CEG

NEW QUESTION 6
- (Topic 3)
When a custom table is created, which access control rules are automatically created? Choose 4 answers

A. delete
B. create
C. execute
D. read
E. update
F. write

Answer: ABDF

NEW QUESTION 7
- (Topic 3)
When building an extended table from a base table, which fields do you need to create? Choose 2 answers

A. The mandatory fields for the base table.
B. The reference fields for the base table.
C. The fields that are not in the base table.
D. The fields that are specific to the extended table.

Answer: CD

NEW QUESTION 8
- (Topic 3)
Which type of ServiceNow script runs on the web browser?

A. Server script
B. Local script
C. Database script
D. Client script

Answer: D

NEW QUESTION 9
- (Topic 3)
On the Form header, which icon do you use to access form templates?

A. Paperclip
B. Pages
C. Stamp
D. More Options {...)

Answer: D

NEW QUESTION 10
- (Topic 3)
User records are stored in which table?

A. User [sys_user]
B. User [sn_user]
C. User [u_sys_user]
D. User [s_user]

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/concept/c_UserPreferences.html
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NEW QUESTION 10
- (Topic 3)
Which field (or fields) is used as a unique key during imports?

A. Match Fields
B. Coalesce Fields
C. Key Fields
D. Sys IDs

Answer: B

Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/new_to_servicenow/app_store_learnv2_importingdata_quebec_coalescing

NEW QUESTION 13
- (Topic 3)
What role enables someone to authorize a request, with no other permissions on the platform?

A. Approver [approver-user]
B. Authorize [authorize-user]
C. Reviewer [reviewer_user]
D. Approver Group [approval_group]
E. Verification [verify_user]

Answer: A

NEW QUESTION 15
- (Topic 3)
What section on a task record is used to see the most recent updates made to a record?

A. Related List
B. Activity Stream
C. Audit Log
D. Timeline

Answer: B

NEW QUESTION 18
- (Topic 3)
The customer has asked that your change the default layout of the task list.
* Number
* Task Type
* Parent
* Short Description
* Assignment Group
* Assignment
* Updated
After navigation to the list, where would you click, to meet this requirement?

A. Right click on any column header, Context menu > Configure > List Layout
B. Right click List Gear icon > Configure > Columns
C. Click List Context Menu >Personalize List
D. Click List Context Menu > Configure Columns

Answer: B

NEW QUESTION 23
- (Topic 3)
‘Your customer has a Human Resources knowledge base, which is only accessible to members of the Human Resources department. A new procedure regarding
employee quarterly reviews needs to be published to the quarterly review category of the HR knowledge base, but should only be visible for HR managers. How
would you meet this requirement?

A. On the Knowledge Base, add User Criteria with a Manager Can Read script to the Can Read list, publish article to any category
B. Add User Criteria for HR Manager Group on the Category’s Can Read list
C. On the Knowledge Article, add an Access Control for HR Manager Group on the Can Read list, then publish article to any category.
D. Add User Criteria for HR Manager Group on the Can Read list of the article

Answer: B

NEW QUESTION 26
- (Topic 3)
What section on a task record would you use to see the most recent update made to a record?

A. Timeline
B. Journal
C. Audit Log
D. Activity
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Answer: D

NEW QUESTION 27
- (Topic 3)
In what order are Access Controls evaluated?

A. Field-level - mast general to most specific: then Row-level - most specific to most general
B. Table-level - most specific to most general; then Row-level - most specific to most general
C. Table-level - most specific to most general; then Field-level « most specific to mast general
D. Field-level - most specific to most general: then Table-level - most specific to most general

Answer: D

NEW QUESTION 32
- (Topic 3)
For your implementation, the following tables. are extended fram each ofher:
* Incident table is extended from Task table.
* Super Incident table is extended from Incident table,
In this situation, which table(s) are P arent, Child and Base tables? Choose 5 answers

A. Incident table is a Base table
B. Incident table i
C. a Parent table
D. Incident table is a Child table
E. Super Incident table is a Child table
F. Super Incident table is a Parent table
G. Super Incident table is a Base table
H. Task table is a Base table
I. Task table is a Parent table
J. Task table is a Child table

Answer: BCDGH

NEW QUESTION 34
- (Topic 3)
What are the main components of the Form Design interface? (Choose three.)

A. Field Layout
B. Page Header
C. Field Navigator
D. Field Picker
E. Form Layout

Answer: BCE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/form-administration/concept/c_FormDesign.html

NEW QUESTION 37
- (Topic 3)
What framework can be used to manage the tables and Cis associated with a use case?

A. Common Service Date Model (CSDM) product view
B. Scename Dashboard
C. CMDB Use Case Modelar
D. CI Use Case Modeler

Answer: A

NEW QUESTION 40
- (Topic 3)
Which modules can you use to create a new table? Choose 2 answers

A. Tables & Columns
B. Schema Map
C. Dictionary
D. Tables

Answer: AD

NEW QUESTION 45
- (Topic 3)
Which feature ensures data consistency white importing data using import sets and web services?

A. Client Script
B. Ul Policy
C. Data Policy
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D. CSDM
E. Business Rule

Answer: C

Explanation: 
 Data policies are used to define rules that govern the creation, modification, and deletion of data in ServiceNow. These policies can be used to ensure data
consistency by enforcing data quality standards and preventing invalid or inaccurate data from being imported.
References:
? ServiceNow Product Documentation: Data policies overview - https://docs.servicenow.com/bundle/vancouver-platform-
administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 47
- (Topic 3)
You have been asked to configure a form so an employee could a tablet and select the
standard accessary options to purchase with it. These standard options are: carrying case, screen cleaner, tablet stand, and screen protector. What approach
would you take?
Choose 3 answers

A. Create Catalog item for the tablet, and on the form, add a check box variable for each accessary option.
B. Create Catalog item for the tablet, and add a variable set to the form, for the accessary options.
C. Create one Catalog item for each: tablet, carrying case, screen cleaner, tablet stand, and screen protector.
D. Create a Records producer, and on the form, add a check box variable for each accessary option.
E. On shopping Cart configuration, select option to show the Add Accessories button.

Answer: ABC

NEW QUESTION 49
- (Topic 3)
When using Flow Designer what is the Flow Execution initiated by?

A. A trigger
B. An existing subflow
C. Allow logic
D. An execution data pill

Answer: A

Explanation: 
 A trigger is an activity that, once specified, automatically initiates a flow1. A trigger specifies the conditions that start running the flow, such as creating a record in
a specified table, receiving an inbound email, or reaching an SLA target1.
References
? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 50
- (Topic 3)
A new employee joins the IT deployment and needs to perform work assigned to Network and Hardware groups. How would you set up their access?
Choose 3 answers

A. Add User Account to itll group
B. Add User Account to ACL
C. Add User Account to network group
D. Add User Account to IT Knowledgebase
E. Create User Account
F. Add User Account to Hardware group

Answer: BCF

NEW QUESTION 54
- (Topic 3)
What options can you see, when you fight click on a Cl, from the Cl dependency view map? Choose 3 answers

A. View Affected Cis
B. View Related Tasks
C. View Recent Outages
D. View Cases
E. View Knowledge

Answer: ABC

NEW QUESTION 57
- (Topic 3)
What section on the notes tab, shows the history of the work documented on the record?

A. Journal
B. Activity
C. Diary
D. Audit Log
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E. Timeline

Answer: B

NEW QUESTION 62
- (Topic 3)
You have been asked to create a way for users to order a new iPhone, but only if they get two levels of approval. The approvers and users should be automatically
notified at each approval level. What feature would you use to manage the approvals and notifications?

A. Parent-Child Approvers.
B. Approval Chains
C. Flows
D. Approval Criteria
E. Approver Delegates

Answer: D

NEW QUESTION 67
- (Topic 3)
When you set a policy that is applied to all data entered into the platform (UI, Import Sets, or Web Services), where does this policy run by default?

A. Client
B. Server
C. Browser
D. Network

Answer: B

NEW QUESTION 71
- (Topic 3)
On Access Control Definitions, what are ways you can set the permissions on a Table? Choose 3 answers

A. Groups
B. CRUD
C. Roles
D. Script that sets the answer variable to true or false
E. Conditional Expressions

Answer: CDE

NEW QUESTION 76
- (Topic 3)
Your customer requires that they be able to monitor which users are performing impersonations in their instance. What would you do to meet that requirement?

A. Add the role Log Write [sn_log_write] to the Impersonator Group
B. Create user update set for impersonation tracking
C. Activate the glide.sys.log_impersonation prop
D. From User icon, select Elevate Roles
E. On the Impersonator role record, right click and select Create Log

Answer: C

Explanation: 
 Reference https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0717055

NEW QUESTION 77
- (Topic 3)
After finishing your work on High Security Settings, what is a possible way to return to normal admin security levels?

A. Use System Administration > Normal Security module
B. Select Normal role
C. Log out and back in
D. Select Global Update Set
E. End impersonation

Answer: A

Explanation: 
 The System Administration > Normal Security module is the recommended way to return to normal admin security levels after finishing your work on High Security
Settings. This module will automatically disable all high security settings and restore your permissions to their original state.
References:
? ServiceNow Product Documentation: High Security Settings - https://docs.servicenow.com/bundle/vancouver-platform-
security/page/administer/security/reference/high-security-plugin.html
? ServiceNow Community: How to disable High Security Settings - https://www.servicenow.com/community/now-platform-forum/platform-security-everything-you-
need-to-know/m-p/2554570

NEW QUESTION 82
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- (Topic 3)
What ServiceNow feature can be triggered by events, and is used to inform users about activities or updates in ServiceNow?

A. Notifications
B. Alerts
C. Texts
D. Events
E. Emails

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/platform-events/concept/events.html

NEW QUESTION 83
- (Topic 3)
Which action enables personalization in a form for the admin role, only?

A. Navigate to sys_form_properties.list and set the property glide.ui.enable_personalize_form.admin to true.
B. Navigate to Context Menu > Configure > Form Layout and select 'Enable Personalization' and Enter the 'admin' role.
C. Navigate to Context Menu > Configure > Table and add the role 'Admin' in the 'Available User' list box.
D. Navigate to sys_properties.list find the property glide.ui.personalize_form.role and set the Value to admin.

Answer: D

Explanation: 
 This action allows only users with the admin role to personalize forms by using the Personalize Form button1. The other options are either invalid or do not restrict
personalization to the admin role only.
ReferencesPersonalize a formUI settings and personalizationPersonalization

NEW QUESTION 88
- (Topic 3)
An order for new office equipment has Men placed through the Service Catalog. How would you view the lists of requests after the orders have Men placed?

A. All > Service Catalog > Open Records > Items
B. In the Navigation Filter, type 'request
C. Let' and press the Enter key.
D. All > Tables and Columns > Taste
E. All > Service Catalog > Requests

Answer: A

NEW QUESTION 90
- (Topic 3)
On a Business Rule, the When salting determines at what point the rule executes. What are the options for specifying that timing?

A. Insert, Update, Delet
B. Query
C. 4G} Before, After, Async, Display
D. Prior to, Synchronous, on Update
E. Before, Synchronous, Scheduled Job, View

Answer: B

NEW QUESTION 95
- (Topic 3)
What are the three key tables in an enterprise CMDB? Choose 3 answers.

A. omadb_rel_ci
B. sn_emdb
C. sn_emdb_ci
D. Ey omdb
E. sn_emdb_bak
F. omdb_ci
G. emdb_bak

Answer: ADF

NEW QUESTION 100
- (Topic 3)
When adding a related list to a form, you choose the related list from the list callector, What is an example of a related list you might see on the list collector?
Choose 3 answers:

A. Release Phase==Parent
B. Catalog Task->Parent
C. HR Case-=Parent
D. Problem==Parent
E. Outage->Task number
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Answer: BCE

NEW QUESTION 103
- (Topic 3)
What feature do you use to specify which users are able to access a Service Catalog Item?

A. Can Read Role
B. Catalog User Role
C. Can Order Tab
D. User Criteria

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow- platform/page/product/service-catalog-management/task/t_AppUserCritItemsCat.html

NEW QUESTION 107
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table
B. Ensures user can get to work as quickly as possible
C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355

NEW QUESTION 108
- (Topic 3)
A form displays information about one record at the top, for example a User, Additional records, which are associated with that User, are displayed on tabs at the
bottom of the form. What are those tabs called?

A. Additional Info
B. More Info
C. Related Links
D. Related Lists

Answer: D

NEW QUESTION 111
- (Topic 3)
Which low components allow you to specify when a flow should be run?

A. Trigger and Condition Pill
B. Scope and Trigger Condition
C. Trigger and Condition
D. Trigger Criteria and Clock
E. Condition and Table

Answer: C

Explanation: 
 Triggers define when a flow should start running, and conditions are used to specify the specific circumstances under which a flow should run. By combining
triggers and conditions, you can create flows that run only when specific events occur and only for certain types of records.
References:
? ServiceNow Product Documentation: Flow Designer - Overview - https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-
designer/concept/flow-designer.html
? ServiceNow Product Documentation: Flow triggers - https://docs.servicenow.com/bundle/tokyo-application-development/page/administer/flow-
designer/reference/flow-triggers.html

NEW QUESTION 116
- (Topic 3)
Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer
B. Process Automation Designer
C. Process Workflow Designer
D. Workflow Editor

Answer: B

NEW QUESTION 121
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- (Topic 3)
When importing spreadsheet data into ServiceNow, in which step does the data get written to the receiving table?

A. Run Transform
B. Run Import
C. Import Dataset
D. Execute Transform
E. Schedule Transform

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/paris-platform-administration/page/script/server-scripting/task/t_CreatingAFieldMap.html

NEW QUESTION 122
- (Topic 3)
What access does a user need to be able to import articles to a knowledge base?

A. sn_knowledge_import
B. sn_knowledge contribute
C. Can contribute
D. Can import

Answer: C

NEW QUESTION 124
- (Topic 3)
An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication
B. Their user account is not logged in properly
C. Their user account was not approved by their manager
D. Their user account does not have itil role
E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 126
- (Topic 3)
Which set of steps is used to import spreadsheet data into a ServiceNow table?

A. Load Data, Create Transform Map, Run Transform
B. Select Import Set, Select Transform Map, Run Transform
C. Select Data Source, Schedule Transform
D. Define Data Source, Select Transform Map, Run Transform

Answer: A

Explanation: 
 These are the steps to import spreadsheet data into a ServiceNow table, as explained in the official documentation1 and the video tutorial2. The other options are
either incomplete or incorrect.
References1: Import a spreadsheet - Product Documentation: Utah - Now Support Portal2: How To Import Data Into ServiceNow - YouTube

NEW QUESTION 127
- (Topic 3)
You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.
B. Activate the application plug in, on your personal dev instance.
C. Search the wiki for the sales demo request form,
D. Activate the application plug in, on your company's production instance.

Answer: B

NEW QUESTION 132
- (Topic 3)
On a form, which type of Geld has this icon which can be clicked, 10 S00 a preview of the associated record?
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A. Drilkdown
B. Lookup
C. Quickview
D. Preview
E. Snapshot
F. Reference:

Answer: F

NEW QUESTION 134
- (Topic 3)
What icon do you use to change the icon and color on a Favorite’?

A. Star
B. Triangle
C. Pencil
D. Clock

Answer: C

NEW QUESTION 136
- (Topic 3)
The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response
B. Save + Update
C. Write + Read
D. Submit + Query
E. Insert + Verify

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 141
- (Topic 3)
ServiceNow contains over 25 different report types. What are some of the types? Choose 5 answers

A. Pie
B. Speedometer
C. Odometer
D. Thermometer
E. Horizontal Bar
F. Semi-Donut
G. Donut

Answer: ABEFG

NEW QUESTION 146
- (Topic 3)
Which best describes a field in a SeniceNow table?

A. A field is a table cell that stores data
B. A field is a table row
C. A field is an item that appears in a menu list
D. A field is a record in a table

Answer: C
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NEW QUESTION 147
- (Topic 3)
What component of the ServiceNow infrastructure defines every table and field in the system?

A. Data Atlas
B. Table Class Manager
C. Schema
D. Dictionary
E. Field Map

Answer: D

NEW QUESTION 152
- (Topic 3)
Many actions are included with flow designer, what are some frequently used core actions? Choose 4 answers.

A. Wait for Condition
B. Ask for Approval
C. Create Record
D. Wait for Match
E. Look for Update
F. Look Up Record

Answer: BCDF

NEW QUESTION 154
- (Topic 3)
You are asked to create an option in the Service Catalog, which will allow a user to click Get Help and describe the issue they are having. These forms should
create incident records, which are automatically routed to the Service Desk. Which method would you use?

A. Create Record Producer
B. Create Catalog Item
C. Create Order Guide
D. Create Content Item

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/orlando-it-service-management/page/product/service-catalog-management/concept/request-fulfillment.html

NEW QUESTION 155
- (Topic 3)
How is a user defined in ServiceNow?

A. user is a record stored in the User Preference [Sys_user_preference] table
B. A User is a record stored in the Profile [sys_user_profile] table
C. A user is 2 field in the LOAP integration
D. A user is a record stored in the User [sys_user] table

Answer: A

NEW QUESTION 159
- (Topic 3)
When importing spreadsheet data into ServiceNow, what is the first step in the process?

A. Create Import Set
B. Run Data Scrubber
C. Set Coalesce
D. Define Data Source
E. Select Import Set

Answer: A

NEW QUESTION 162
- (Topic 3)
After you create a new table, what is the best practice regarding the navigation pane? Choose 2 answers

A. Set the filter condition on the Application Menu
B. Set the font style on both the Application Menu and the Module
C. Specify which Roles are able ta see the Module
D. Specify which Roles are able to see the Application Menu
E. Create Application Menu with the same name as the table label
F. Create Module with the plural of the table label

Answer: CD
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NEW QUESTION 167
- (Topic 3)
You are looking at a list of Active incidents. You want to exclude incidents with the state of Resolved. How might you do that?

A. On the list of records, locate the right-click on the Resolved value, select Exclude.
B. Click Funnel icon, click AND, Select Resolved, is Not State click Run
C. On state column title, right-click, select Filter Out > Resolved
D. On Search, select State, type not Resolved, press enter
E. On the list of records, locate and right-click on the Resolved value, select Filter Out

Answer: E

NEW QUESTION 172
- (Topic 3)
What instance resource allows you to access guided tours, information about actions, and instructions an how to use inputs and outputs in your flaw?

A. Community
B. Help Panel (question mark icon)
C. Docs
D. Wiki

Answer: B

NEW QUESTION 175
- (Topic 3)
Which element is used to track items not saved with a field, in a record?

A. Sidebar
B. List Editor
C. Activity formatter
D. Dictionary

Answer: C

Explanation: 
 The activity formatter provides an easy way to track items not saved with a field in the record, such as journal fields like comments and work notes1.
ReferencesFormatters and Related Lists

NEW QUESTION 178
- (Topic 3)
Which data consistency settings can be achieved using UI Policy? Choose 3 answers

A. Setting fields to accept the data with ‘n’ number of characters
B. Setting fields hidden
C. Setting fields to accept the data in an expected format
D. Settings fields read-only
E. Setting fields mandatory

Answer: BDE

NEW QUESTION 180
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon
B. Additional Actions or Context Menu
C. Hamburger icon
D. Cake icon

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 183
- (Topic 2)
On the Reports page, what sections allow you to see which reports are visible to different audiences? (Choose four.)

A. Group
B. Department
C. My reports
D. Team
E. Dashboards
F. Global
G. Admin
H. Analytics
I. All
J. Company
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Answer: AEFG

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/task/t_ShareASetting.html

NEW QUESTION 187
- (Topic 2)
What are three security modules often used by the System Administrator? (Choose three.)

A. System Properties > Security
B. Utilities > Migrate Security
C. System Security > Security
D. Self-Service > My Access
E. System Security > Access Control (ACL)
F. Password Management > Security Questions
G. System Security > High Security Settings

Answer: AEG

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/reference/r_GeneralSecuritySettings.html

NEW QUESTION 188
- (Topic 2)
ServiceNow contains a resource which provides the following:
A standard and shared set of service related definitions across ServiceNow products and platform that will enable and support true service level reporting.
A CMDB framework across our products and platform that will enable and support multiple configuration strategies.
What resource do these statements describe?

A. Common Services Data Model (CSDM)
B. Information Technology Service Management (ITSM)
C. Configuration Management Database (CMDB)
D. Information Technology Infrastructure Library (ITIL)

Answer: A

Explanation: 
Reference: https://www.servicenow.com/content/dam/servicenow-assets/public/en-us/doc-type/resource-center/solution-brief/sbr-servicenow-common-service-data-
model.pdf

NEW QUESTION 193
- (Topic 2)
Two departments (HR Onboarding and Facilities) have come to you, asking for a way for employees to request event room set up services. The requirements are
the same for the form and the task routing to the Facilities’ assignment group.
For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation sessions.
For Facilities, the item will be used for anyone in the company who needs room set up services.
However, both departments have their own service catalogs. What do you do, to support these requirements?

A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.
C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is accessible to both HR and Facilities.
D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.

Answer: C

NEW QUESTION 198
- (Topic 2)
What feature can track the amount of time that a task has been open, to ensure that tasks are completed within an allotted time?

A. Task Escalation Clock
B. Service Level Agreements
C. Inactivity Monitor
D. Response Time Clock
E. Business Time Remaining

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform- administration/page/administer/task-
table/reference/r_ToolsForDrivingTasks.html#:~:text=Service%20level%20agreements%20
can%20track,completed%20within%20an%20allotted%20time.&text=Inactivity%20monitors
%20ensure%20that%20tasks,a%20predefined%20period%20of%20time

NEW QUESTION 202
- (Topic 2)
Which core table in the ServiceNow platform provides a series of standard fields used on each of the tables that extend it, such as the Incident [incident] and
Problem [problem] tables?
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A. Task [task]
B. Assignment [assignment]
C. Service [service]
D. Workflow [workflow]

Answer: A

NEW QUESTION 207
- (Topic 2)
When you need to orchestrate business processes across services with little technical user knowledge, which utility would you use?

A. Flow Manager
B. Flow Designer
C. Flow Editor
D. Workflow Editor
E. Workflow Designer

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/orchestration/reference/r-orchestration-introduction.html

NEW QUESTION 211
- (Topic 2)
Which icon would you double click, to expand and collapse the list of all Applications and Modules?

A. Star
B. Clock
C. Application
D. Funnel

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/task/ui16-navigator-tasks.html

NEW QUESTION 214
- (Topic 2)
Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that is specific to the Incident table and the Major
Incident field?

A. Incident.Major_Incident
B. incident=>major_incident
C. incident<=>major_incident
D. incident||major_incident
E. incident.major_incident

Answer: E

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/contextual-security/concept/acl-rule-types.html

NEW QUESTION 216
- (Topic 2)
What is a quick way to create a report from a list view?

A. Click on filter breadcrumb, drag and drop on the Report > Create New module
B. Click Funnel, define filter conditions, click Create Report
C. Click Context Menu, select Create Report
D. Apply filter, right click on column header, select Bar Chart
E. Apply filter, right click on column header, select Create Report
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Answer: B

Explanation: 
Reference: https://ut.service-now.com/sp?id=kb_article&number=KB0014148

NEW QUESTION 221
- (Topic 2)
IntegrationHub enables execution of third-party APIs as a part of a flow. These integrations are referred to as

A. an action
B. a spoke
C. a connection
D. an integration step

Answer: B

NEW QUESTION 225
- (Topic 2)
While showing a customer their incident form, they ask to change the Priority values to display their internal terminology P1, P2, P3, P4. They want it to be
consistent across all Tasks. How would you do that?
Right click on Priority and select what?

A. Configure Lists
B. Show Options
C. Configure Task
D. Show Choices
E. Show Choice List
F. Configure Options

Answer: F

NEW QUESTION 227
- (Topic 2)
What field contains a record’s 32-character, unique identifier?

A. sn_rec_id
B. rec_id
C. u_id
D. sys_id
E. sn_gu_id
F. sn_sys_id
G. id

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/table-administration/concept/c_UniqueRecordIdentifier.html

NEW QUESTION 228
- (Topic 2)
What is a no-code approach to control the mandatory or read-only state of a form field?

A. UI Action
B. Client Script
C. UI Script
D. UI RuIe
E. UI Policy

Answer: E

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 230
- (Topic 2)
After finishing your work on High Security Settings, what do you do to return to normal admin security levels?

A. Select Normal role
B. Log out and back in
C. Use System Administration > Normal Security module
D. Select Global Update Set
E. End Impersonation

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/concept/c_HighSecuritySettings.html
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NEW QUESTION 234
- (Topic 2)
When does the Submit button appear on a form?

A. When saving an old record
B. When creating a new record
C. When changing the reference field in an existing record
D. When updating an existing record

Answer: B

NEW QUESTION 238
- (Topic 2)
Which one of the following statements is true?

A. When an incident form is saved, all the Work Notes field text is recorded to the Activity Log field
B. When an incident form is saved, the Work Notes field text is overwritten each time work is logged against the incident
C. When an incident form is saved, the impact field is calculated by adding the Prion:, and Urgency values
D. When an Incident form is saved, the Additional Comments field text is cleared and recorded to the Work Notes section

Answer: D

NEW QUESTION 242
- (Topic 2)
What is the name of the table relationship, where two or more tables are related in a bi- directional relationship, so that the related records are visible from both
tables in a related list?

A. Database View
B. Many to Many
C. One to Many
D. Extended

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataManagement.html

NEW QUESTION 244
- (Topic 2)
Which plugin allows users to install multiple applications, application-customizations. or plugins at once?

A. Application Integration and Plugin Delivery (A1PD) SpokeBatch Install
B. Continuous Integration and Continuous Delivery (CICD) SpokeBatch Install
C. Multiple Integration and Process Delivery (MIPD) SpokeBatch Install
D. Quick Integration and Multiple Delivery (QIMD) SpokeBatch Install

Answer: B

NEW QUESTION 246
- (Topic 2)
Which plugin needs to be activated in order to translate the content of a catalog item to multiple languages?

A. Localization Framework plugin (com.glide.localization_framework)
B. Translation Framework plugin (com.glide.translation_framework)
C. Multiple Language Framework plugin (com.glide.multiple.language_framework)
D. Language Al Framework plugin (com .g I id
E. language.ai _framework)

Answer: A

NEW QUESTION 249
- (Topic 2)
What type of field allows you to look up values from one other table?

A. Reference
B. Verity
C. Options
D. Selections
E. Dot walk
F. Lookup

Answer: A

Explanation: 
Reference: https://support.microsoft.com/en-us/office/create-or-delete-a-lookup-field-87e84cbd-d60c-4473-8a98-
3e391c42f239#:~:text=A%20lookup%20field%20can%20display,order%20in%20the%20Orders%20table
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NEW QUESTION 253
- (Topic 2)
When a user reports that they are not able to see modules on the application navigator, what can you do, to see what modules are visible to them?

A. Look up their password, so you can login with their account
B. Initiate a Connect Chat session
C. Install the Bomgar plug-in
D. Impersonate the user
E. Launch a NowChat window

Answer: B

NEW QUESTION 257
- (Topic 2)
What do you call any component that needs to be managed in order to deliver services?

A. CSDM Items
B. CMDB
C. Configuration item
D. Service Offerings
E. Asset

Answer: C

Explanation: 
Reference: https://infocenter.io/servicenow-cmdb-implementation/

NEW QUESTION 260
- (Topic 2)
When moving multiple update sets at one time, what might you do to facilitate the move?

A. Batch
B. Verify
C. Test
D. Preview

Answer: A

Explanation: 
Reference: https://www.servicenowelite.com/blog/2016/8/7/update-sets

NEW QUESTION 264
- (Topic 2)
Which one of the following is an accurate list of changes that are captured in an Update Set?

A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields
C. Changes made to: tables, form
D. Business Rules, and data records
E. Changes made to: table
F. forms groups, and configuration items (Cls)

Answer: A

NEW QUESTION 269
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator
B. Match Criteria
C. Value
D. Column
E. Field

Answer: ACE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 271
- (Topic 2)
What ServiceNow tables can Administrators define as "destinations" for imported data, when using Transform Maps in the System Import Sets application?

A. The Task table is the only table that can be a destination for imported data in the Transform Map module
B. The Inciden
C. Proble
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D. Change, Task, and Service Catalog tables are the only tablesthat can be a destination for imported data m the Transform Map module
E. Only the Incident Problem, and Change tables can be a destination for imported data in the Transform Map module
F. Any ServiceNow table can be a destination for imported data in the Transform Map module

Answer: B

NEW QUESTION 273
- (Topic 2)
What controls the publishing and retiring process for knowledge articles?

A. Approval Policies
B. Approval Definitions
C. Workflow Designer
D. Workflows
E. State Lifecycle

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeWorkflows.html

NEW QUESTION 275
- (Topic 2)
What icon do you use to change the label on a Favorite?

A. Clock
B. Hamburger
C. Pencil
D. Three dots
E. Triangle.
F. Star

Answer: C

Explanation: 
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0781451

NEW QUESTION 279
- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke
B. Activate trigger security rules
C. Activate application spoke, and plug-ins as needed
D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 280
- (Topic 2)
What needs to be specified, when creating a Business Rule? (Choose four.)

A. UI action
B. Table
C. Fields to update
D. Who can run
E. Script to run
F. Application scope
G. Update set
H. Timing
I. Condition to evaluate

Answer: ABEF

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/task/t_EditingAUIAction.html

NEW QUESTION 281
- (Topic 2)
What is a sys_id?

A. Unique 32-character identifier that is assigned to every record
B. A client-side Business Rule
C. A server-side Business Rule
D. Unique 64-character identifier that is assigned to every record

Answer: 
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A

NEW QUESTION 284
- (Topic 2)
The ServiceNow platform includes which types of interfaces? (Choose three.)

A. Now Mobile Apps
B. Agent Control Center
C. Back Office Dashboard
D. Service Portals
E. Now Platform® User Interfaces
F. Field Service Taskboard

Answer: ADE

Explanation: 
 A. https://docs.servicenow.com/bundle/rome-mobile/page/administer/tablet-mobile-ui/concept/mobile-config-navigation.html D and E.
https://www.servicenow.com/products/service-portal.html

NEW QUESTION 285
- (Topic 2)
How are local flow variables accessed in the Flow Designer Data panel?

A. As newly generated icons
B. As scratchpad variables
C. As new tabs
D. As data pills

Answer: D

NEW QUESTION 286
- (Topic 2)
Which section of the ServiceNow UI allows you to perform a global search?

A. Application Navigator
B. Banner frame
C. List pane
D. Content frame

Answer: B

NEW QUESTION 289
- (Topic 2)
An IT manager is responsible for the Network and Hardware assignment groups, each group contains 5 team members. These team members are working on
many tasks, but the manager cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
B. The manager does not have the itil role.
C. The manager is not a member of the Service Desk group.
D. The manager is not a member of the Network and Hardware groups.
E. The Assignment Group manager field is empty.

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/task/t_CreateAGroup.html

NEW QUESTION 290
- (Topic 2)
What are different types of Data Sources, which may be imported into ServiceNow? (Choose four.)

A. Local Sources (i.
B. XML, CSV, Excel)
C. Implementation Spoke
D. DataHub
E. JDBC Connection
F. Network Server
G. LDAP Connection

Answer: ACDF
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Explanation: 
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/servicenow_administrator/app_store_learnv2_importingdata_quebec_data_s
ources

NEW QUESTION 293
- (Topic 2)
What are two ways to generate an Event? (Choose two.)

A. Business Rule
B. Workflow
C. Log entry
D. Knowledge article publication

Answer: AB

NEW QUESTION 295
- (Topic 2)
In addition to the admin role, which one of the following roles allows a user to add or remove fields from a list?

A. personal ize.control
B. personal_list
C. ul_page_admin
D. ui_action_admin

Answer: A

NEW QUESTION 296
- (Topic 2)
Access Control rules may provide access security for which of the following database objects?

A. For a specific role, group, or user
B. For a specific row, column, or table
C. For specific groups
D. For a specific CMDB Configuration item

Answer: D

NEW QUESTION 297
- (Topic 2)
Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot
C. Virtual Agent
D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 299
- (Topic 2)
How can administrators utilize the same content for different notification channels?

A. Configure Default notification content
B. Enable Actionable notification content
C. Provide Common notification content
D. Set up Related notification content

Answer: C

NEW QUESTION 301
- (Topic 2)
Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log
C. Access Control Rules
D. Application Scope

Answer: D

NEW QUESTION 306
- (Topic 2)
What is the purpose of a Data Policy?
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A. Data Policies enforce security
B. Data Policies standardize data in Update Sets
C. Data Policies enforce data consistency
D. Data Policies apply to lists to standard data

Answer: C

NEW QUESTION 308
- (Topic 1)
database live at the Data Center.

A. True
B. False

Answer: A

NEW QUESTION 311
- (Topic 1)
When searching using the App Navigator search field, what can be returned? (Choose four.)

A. Names of Applications and Modules
B. Names of Modules
C. Names of Applications
D. Favorites
E. History Records
F. Titles of Dashboard Gauges

Answer: ABCD

NEW QUESTION 312
- (Topic 2)
Which tool is used to define relationships between fields in an import set table and a target table?

A. Transform Schema
B. Schema Map
C. Dictionary Map
D. Transform Map
E. Field Transformer
F. Import Designer

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/import-sets/concept/c_ImportSetsKeyConcepts.html

NEW QUESTION 315
- (Topic 2)
What import utility do you use when the field names on the import set match the name of the fields on the Target table?

A. Schema Mapping
B. Automatic Mapping
C. Mapping Assist
D. Mapping Dashboard

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/script/server-scripting/concept/c_MappingOptions.html

NEW QUESTION 318
- (Topic 2)
Which tool is used for creating dependencies between configuration items in the CMDB?

A. CI Relationship Editor
B. CMDB Builder
C. CI Service Manager
D. Cl Class Manager

Answer: D

NEW QUESTION 322
- (Topic 1)
What information does the System Dictionary contain?

A. The human-readable labels and language settings
B. The definition for each table and column
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C. The information on how tables relate to each other
D. The language dictionary used for spell checking

Answer: B

NEW QUESTION 324
- (Topic 1)
A knowledge article must be which of the following states to display to a user?

A. Published
B. Drafted
C. Retired
D. Reviewed

Answer: A

NEW QUESTION 326
- (Topic 1)
There are _____ common types of Interfaces (Numeric Value) 6: There are six common types of interfaces

A. Homepage: Consists of navigational elements, functional controls, and platform information.
B. List: Display records from a data table, as well as allow you to edit the record information using the List Editor functionally.
C. Form: Data is entered into ServiceNow through forms
D. Dashboard: Enable you to display multiple performance analytics, reporting and other widgets on a single screen.
E. Maps: Display ServiceNow data graphically on a Google map
F. Timelines: Used to track tasks or projects

Answer: C

NEW QUESTION 328
- (Topic 1)
When working on a form, what is the difference between Insert and Update operations?

A. Insert creates a new record and Update saves changes, both remain on the form
B. Insert creates a new record and Update saves changes, both exit the form
C. Insert saves changes and exits the form, Update saves changes and remains on the form
D. Insert saves changes and remains on the form, Update saves changes and exits the form

Answer: B

NEW QUESTION 333
- (Topic 1)
What is (are) best practice(s) regarding users/groups/roles? Choose 2 answers

A. You should never assign roles to groups.
B. You should assign roles to users.
C. You should assign roles to groups
D. You should add users to groups

Answer: CD

NEW QUESTION 338
- (Topic 1)
What are the four knowledge workflows available in the ServiceNow base instance?

A. Approval publish: Request approval from a manager of the knowledge base before moving the article it the publish state
B. Instant Publish: Immediately publishes a draft article without requiring an approval
C. Instant Retire: Immediately retires a published article without requiring an approval
D. Retire Knowledge: Moves a knowledge article to the retired state.

Answer: A

NEW QUESTION 342
- (Topic 1)
What are the main UI component(s) of the ServiceNow Platform?

A. Banner Navigator
B. Banner Frame
C. Application Frame
D. Application Navigator
E. Content Menu
F. Content Frame

Answer: BDF

NEW QUESTION 344
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- (Topic 1)
Which of the following statement describes the purpose of an Order Guide?

A. Order Guides restrict the number of items in an order to only one item per request
B. Order Guide provide a list of guidelines for Administrators on how to set up item variables
C. Order Guide provide the ability to order multiple, related items as one request
D. Order Guides take the user directly to the checkout without prompting for information

Answer: C

NEW QUESTION 348
- (Topic 1)
Business Rules are used to enforce mandatory data on a form.

A. True
B. False

Answer: B

NEW QUESTION 352
- (Topic 1)
Knowledge articles within a knowledge base are grouped by category.

A. True
B. False

Answer: A

NEW QUESTION 353
- (Topic 1)
Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog
B. Self Service
C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 357
- (Topic 1)
What are the 6 methods available for user authentication?

A. Local Database: The user name and password in their user record in the instance database.
B. Multifactor: The user name and password in the database and passcode sent to the user's mobile device that has Google Authenticator installed
C. LDAP: The user name and password are accessed via LDAP in the corporate directory, which has a matching user account in the database.
D. SAML 2.0: The user name and password configured in a SAML identity provider account, which has a matching user account in the database.
E. OAuth 2.0: The user name and password of OAuth identity provider, which has a matching user account in the database.
F. Digest Token: An encrypted digest of the user name and password in the user record.

Answer: ABCDEF

NEW QUESTION 359
- (Topic 1)
Which are valid Service Now User Authentication Methods? (Choose three.)

A. XML feed
B. Local database
C. LDAP
D. SSO
E. FTP authentication

Answer: BCD

NEW QUESTION 364
- (Topic 1)
A role is recorded in which table?

A. Role[sys_user]
B. Role[sys_user_profile]
C. Role[sys_user_record]
D. Role[sys_user_role]

Answer: A

NEW QUESTION 368
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- (Topic 1)
Which of the following can be customized through the Basic Configuration UI 16 module? (Choose three.)

A. Banner Image
B. Record Number Format
C. Browser Tab Title
D. System Date Format
E. Form Header Size

Answer: ACD

NEW QUESTION 372
- (Topic 1)
What is the name of the conversational bot platform that provides assistance to help users obtain information, make decisions, and perform common tasks?

A. Agent
B. live Feed
C. Virtual Agent
D. Connect Chat

Answer: C

NEW QUESTION 374
- (Topic 1)
Reports can be created from which different places in the platform? (Choose two.)

A. List column heading
B. Metrics module
C. Statistics module
D. View / Run module

Answer: AD

NEW QUESTION 375
- (Topic 1)
Which configuration allows you to use a script to coalesce data in Import Sets?

A. Multiple-field coalesce
B. No coalesce
C. Conditional coalesce
D. Single-field coalesce

Answer: C

NEW QUESTION 379
- (Topic 1)
What is a Dictionary Override?

A. A Dictionary Override is an incoming customer update in an Update Set which applies to the same objects as a newer local customer update
B. A Dictionary Override is the addition, modification, or removal of anything that could have an effect on IT services
C. A Dictionary Override is a task within a workflow that requests an action before the workflow can continue
D. A Dictionary Override sets field properties in extended tables

Answer: D

NEW QUESTION 382
- (Topic 1)
Which one of the following statements describes the contents of the Configuration Management Database (CMDB)?

A. The CMDB contains data about tangible and intangible business assets
B. The CMDB contains the Business Rules that direct the intangible, configurable assets used by a company
C. The CMDB archives all Service Management PaaS equipment metadata and usage statistics
D. The CMDB contains ITIL process data pertaining to configuration items

Answer: A

NEW QUESTION 385
- (Topic 1)
What is the difference between UI Policy and UI Action?

A. UI Action can make fields read-only, mandatory, or hidde
B. while UI Policy can make a save button visible for appropriate users.
C. UI Policy can make fields read-only, mandatory, or hidde
D. while UI Action can make a save button visible for appropriate users.

Answer: B
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NEW QUESTION 386
- (Topic 1)
Which term best describes something that is created, has worked performed upon it, and is eventually moved to a state of closed?

A. report
B. workflow
C. event
D. task

Answer: D

NEW QUESTION 391
- (Topic 1)
Which application is used to change the number format per table?

A. Number Maintenance
B. System Maintenance
C. Table Maintenance
D. Record Maintenance

Answer: A

NEW QUESTION 395
- (Topic 1)
Table Access Control rules are processed in the following order:

A. any table name (wildcard), parent table name, table name
B. table name, parent table name, any table name (wildcard)
C. parent table name, table name, any table name (wildcard)
D. any table name (wildcard), table name, parent table name

Answer: B

NEW QUESTION 400
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.
D. They provide options.

Answer: B

NEW QUESTION 403
- (Topic 1)
In what order should filter elements be specified?

A. Field, Operator, then Value
B. Field, Operator, then Condition
C. Operator, Condition, then Value
D. Value, Operator, then Field

Answer: A

NEW QUESTION 408
- (Topic 1)
Which one of these applications is available to all users?

A. Change
B. Incident
C. Facilities
D. Self-Service

Answer: D

NEW QUESTION 412
- (Topic 1)
From the User menu, which actions can a user select? (Choose three.)

A. Send Notifications
B. Log Out ServiceNow
C. Elevate Roles
D. Impersonate Users
E. Order from Service Catalog
F. Approve Records
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Answer: BCD

NEW QUESTION 415
- (Topic 1)
What defines conditions that are evaluated against users to determine which users can create, read, write, and retire knowledge articles.

A. User conditions
B. User info
C. User Criteria
D. User permissions

Answer: C

NEW QUESTION 418
- (Topic 1)
Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance
B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time
D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance

Answer: A

NEW QUESTION 421
- (Topic 1)
Knowledge Base Search results can be sorted by which of the following? (Choose three.)

A. Most recent update
B. Popularity
C. Relevancy
D. Manager assignment
E. Number of views

Answer: ACE

NEW QUESTION 425
- (Topic 1)
What is the master table that contains a record for each table in the database?

A. [sys_master_db]
B. [sys_db_object]
C. [sys_master_object]
D. [sys_object_db]

Answer: B

NEW QUESTION 429
- (Topic 1)
A REQ number in the Service Catalog represents…

A. the order number.
B. the stage.
C. the task to complete.
D. the individual item in the order.

Answer: A

NEW QUESTION 430
- (Topic 1)
Which of the following are a type of client scripts supported in ServiceNow? (Choose four.)

A. onSubmit
B. onUpdate
C. onCellEdit
D. onLoad
E. onEdit
F. onChange
G. onSave

Answer: ACDF

NEW QUESTION 435
- (Topic 1)
UI Action can prompt that an Incident has been successfully submitted.
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A. True
B. False

Answer: A

NEW QUESTION 436
- (Topic 1)
Access Control rules may be defined with which of the following permission requirements? (Choose three.)

A. Roles
B. Conditional Expressions
C. Assignment Rules
D. Scripts
E. User Criteria
F. Groups

Answer: ABD

NEW QUESTION 439
- (Topic 1)
What is the purpose of a Related List?

A. To create a one-to-many relationship
B. To dot-walk to a core table
C. To present related fields
D. To present related records

Answer: D

NEW QUESTION 441
FILL IN THE BLANK - (Topic 1)
FILL IN THE BLANK
________ is a computer program running as a service; a physical computer dedicated to running one or more services, or a system running a database.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Server

NEW QUESTION 445
- (Topic 1)
What are the two aspects to LDAP Integration?

A. Data Population
B. Data formatting
C. Authorization
D. Authentication

Answer: AD

NEW QUESTION 448
- (Topic 1)
A Service Catalog may include which of the following components?

A. Order Guides, Exchange Rates, Calendars
B. Order Guides, Catalog Items, and Interceptors
C. Catalog Items, Asset Contracts, Task Surveys
D. Record Producers, Order Guides, and Catalog Items

Answer: D

NEW QUESTION 453
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD
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NEW QUESTION 456
- (Topic 3)
On a form header, what icon would you click to access Template features?

A. Paper clip
B. More options (...)
C. Stamp
D. Context Menu

Answer: B

NEW QUESTION 458
- (Topic 3)
What ServiceNow feature allows you to include data from a secondary related table on a report?

A. SQL
B. Dot Walking
C. Outer Join
D. Joins

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/concept/c_HowToAccessRelatedTables.html

NEW QUESTION 460
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category
B. On the Filter Menu, select Group By > Category
C. Click Group On icon, select Category
D. On Navigator Filter, type tablename.group.category and press enter
E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 463
- (Topic 3)
What actions are taken to filter a long list of records to show only those with the Category of Hardware?

A. On Breadcrumb, click the > icon, type Hardware and click enter
B. On the Category column header, right-click and select Show > Hardware
C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter
E. Click Funnel icon, type Hardware and click enter

Answer: C

NEW QUESTION 468
- (Topic 3)
What table acts as a staging area for records imported from a data source?

A. Transform Table
B. Staging Table
C. Import Set Row Table
D. Temp Table

Answer: C

NEW QUESTION 470
- (Topic 3)
A Role is defined as what?

A. A collection of permissions
B. A set of user access policies
C. A Persona in a workflow
D. A set of access control rules

Answer: A

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/roles/concept/c_Roles.html
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NEW QUESTION 474
- (Topic 3)
What contains the configuration changes made in an instance (i.e. changes in a form) and
helps to implement the changes from the Dev environment to another environment?

A. Update sets
B. Transform maps
C. System dictionaries
D. Import sets

Answer: A

Explanation: 
Update sets are the configuration changes made in an instance, such as changes in a form, that can be exported from one instance and imported into another.
This helps to implement the changes from the Dev environment to another environment, such as Test or Prod. Update sets capture the changes made to system
properties, UI actions, business rules, workflows, and other customizations.
References1: Get started with update sets - ServiceNow - Now Support2: Product Documentation | ServiceNow3: Update Set in ServiceNow, Captured, Non-
Captured, Commit, Import …4: In depth Concepts Update Set in ServiceNow - Basico ServiceNow Learning5: Retrieving and committing update sets between
different … - ServiceNow

NEW QUESTION 477
- (Topic 3)
How would you define an Access Control, to allow a user with iti role to have permission to create incident records?

A. Name: incident”; Permission: write; Role: itil
B. Name: incident Any, Operation: write, Permission: itil
C. Name: incident.*; Operation: write; Permission: itil
D. Name: incident None, Permission: create: Role: itil
E. Name: inciden
F. None; Operation: create; Role: itil

Answer: D

NEW QUESTION 478
- (Topic 3)
What does Natural Language Query allow you to do on a list?

A. Automatically select a filter, based on keywords
B. Filter list by typing in a phrase
C. Predict the filter desired by the user
D. Speak to the condition builder
E. Set list filter, using audible commands

Answer: A

NEW QUESTION 483
- (Topic 3)
Which admin role is required to make changes to High Security Settings?

A. security _admin
B. sn_ad_admin
C. high_sec_admin
D. admin

Answer: A

NEW QUESTION 485
- (Topic 3)
What are examples of Ul Actions, relating to Lists? Choose 4 answers

A. List Links
B. List Control
C. List Buttons
D. List Context Menu
E. List Override
F. List Choices

Answer: ACDF

NEW QUESTION 488
- (Topic 3)
What are the three key tables in an enterprise CMDB? (Choose three.)

A. cmdb
B. sn_cmdb_bak
C. cmdb_rel_ci
D. sn_cmdb
E. cmdb_bak
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F. cmdb_ci
G. sn_cmdb_ci

Answer: ACF

Explanation: 
Reference: https://community.servicenow.com/community?id=community_question&sys_id=7ab22ad5 dbf20498d82ffb2439961938

NEW QUESTION 493
- (Topic 3)
What do you click when you have made modification to your report, and your want to see the results without saving?

A. Execute
B. Try ir
C. Run
D. Test
E. Preview

Answer: D

NEW QUESTION 495
- (Topic 3)
When creating a new notification, what must you define? Choose 3 answers

A. What is the content of the notification
B. The associated knowledge base
C. Under what conditions is the notification sent
D. Who receives the notification
E. Settings for handling inactive user accounts

Answer: ACD

NEW QUESTION 499
- (Topic 3)
When looking at a long list of records, you want to quickly filler, to show only those which have Shon Description containing email
How might you do that?

A. Click List Magnifier to expand column search, on Short Description, type “email, click enter
B. Click List Magnifier to expand column search, on Short Description, lype *email, click enter
C. Click List Magnifier to expand column search, on Short Description, type email, click enter
D. On Search box, select text, type email, click enter

Answer: A

NEW QUESTION 500
- (Topic 3)
On what part of the ServiceNow instance, would you find the option to Impersonate User?

A. Module
B. Content Frame
C. Application Navigator
D. User Menu

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/concept/c_ImpersonateAUser.html

NEW QUESTION 503
- (Topic 3)
Which tables are available by default in a ServiceNow instance? Choose 3 answers

A. User
B. Incident
C. Item
D. Issue
E. Project
F. Task

Answer: ABF

Explanation: 
These tables are available by default in a ServiceNow instance because they are part of the core platform and are used to store essential data for users, incidents,
and tasks. The other tables are not available by default, but can be created or activated by installing plugins or applications.
References1: Tables & Dictionary - Frequently asked Questions (FAQ) - ServiceNow2: ServiceNow – The List of All Tables (sys_db_object)3: How To Set A
Default Field Value in ServiceNow? - The Snowball
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NEW QUESTION 507
- (Topic 3)

You are editing a new incident record and would like the Save" Dutton to be located on the Form header. Which action would need to be taken for that button to
appear?

A. All > System Properties > Ul Properties > Turn on the glide.ui.advanced* property
B. Context Menu > Form Design > add the Save'' button
C. All > System Properties > Ul Properties > Turn on the Save" button
D. Context Menu > Form Layout > add the Save* button.

Answer: C

Explanation: 
 To add the Save button to the form header, users need to turn on the system property glide.ui.save_button, which enables the Save button on all forms1. Users
can navigate to All > System Properties > UI Properties and search for the property name, then set the value to true1. Alternatively, users can use the
sys_properties.list URL suffix and filter by the property name1.
References
? How to add or enable Save Button on all the forms across a Servicenow Instance - Support and Troubleshooting - Now Support Portal

NEW QUESTION 511
- (Topic 3)

An order from the Service Catalog has been placed. Two records in the Platform are
created as a result. Which two records are associated with tins newly ordered item? Choose 2 answers

A. A record of sc_task
B. A record of sc_req_llem table
C. A change record
D. An Incident record
E. A problem record

Answer: AB

NEW QUESTION 513
- (Topic 3)
What module enables an administrator to define destinations for imported data on any ServiceNow table?

A. Field Transform
B. Transform Map
C. Schema Map
D. Import Map

Answer: B

NEW QUESTION 517
- (Topic 3)
What module do you use to access the reports that are available to you?

A. Report > View /Run
B. Reports > Homepage
C. Self-Service>My Reports
D. Report > Overview

Answer: B
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NEW QUESTION 518
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.
B. Use extremely large Import Sets, instead of multiple large Import Sets.
C. Create a new Import set table for each new data load.
D. Plan time before your import to remove obsolete or inaccurate data.
E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation: 
 This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.
ReferencesImport and export resources page

NEW QUESTION 519
- (Topic 3)
What access does a user need to be able to import anicies to a knowledge base?

A. Can contribute
B. sn_knowledge_contripute
C. sn_knowledge_import
D. Can import

Answer: A

NEW QUESTION 523
- (Topic 3)
Which application is used primarily to load data into ServiceNow?

A. Import Hub
B. System Import Sets
C. Data Import Configuration
D. Import Management

Answer: B

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/import-sets/reference/import-sets-landing-page.html

NEW QUESTION 524
- (Topic 3)
When would you use the following steps?
* 1, Homepage Admin > Pages
* 2. Right click on Homepage record
* 3. Select Unioad Portal Page

A. To publish a Homepage to the Portal
B. To retire a Homepage
C. To delete a Homepage
D. o To add a Homepage to an update set

Answer: D

NEW QUESTION 528
- (Topic 3)
How would you describe the relationship between the incident and Task table?

A. Incident table has a many to many relationship with the Task table.
B. Incident table has a one to much relationship with the Task table.
C. Incident table is extended from task table.
D. incident table is related to the Task table via the INC number
E. incident table is a database view of the Task table

Answer: C

NEW QUESTION 532
- (Topic 3)
How would you navigate to the Schema map for a table?

A. System Dictionary > Show Schema Map; Select Table
B. System Definition > Tables; Select Table; Go to Related links and click Show Schema Map
C. System Definition > Show Schema Map; Select Table
D. System Definition > Dictionary: Select Table; Go to Related links and click Show Schema Map

Answer: 
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B

NEW QUESTION 534
- (Topic 3)
An IT user calls the service desk because his work needs to be completed on ask records. All he can see a Self Service on his homepage when he logs in to the
ServiceNow instance. What issue could explain this?
Choose 2 answers

A. His user account failed LDAP authentication
B. His user account does not Belong to any groups, which contain the ITIL role
C. His user account was not approved by his manager
D. His user account does not have ITIL role
E. His user account Is not logged in properly

Answer: BE

NEW QUESTION 538
- (Topic 3)
Which system property is added and set to true in order to see impersonation events in the System Log?

A. glide user_setting
B. glide sys all_jmpersonation
C. glide sys log_jmpersonabon
D. glide.impersonation_setting
E. glide sys admin_login

Answer: C

Explanation: 
 The system property glide.sys.log_impersonation is added and set to true in order to see impersonation events in the System Log2. This property enables logging
of
impersonation events in the Event [sysevent] table, which can be accessed by navigating to System Logs > Events2.
References
? How to find the history of impersonations - Support and Troubleshooting - ServiceNow

NEW QUESTION 539
- (Topic 3)
What are the benefits of building flows using Flow Designer? Choose 3 answers

A. Supports easy integration with 3rd party systems
B. Provides IDE for complicated scripting
C. Provides natural-langauge descriptions of flow logic
D. Supports No-Code application development
E. Automatically populates SLA records
F. Provides built-in libraries /API for complex coding

Answer: ACD

Explanation: 
The following are the benefits of building flows using Flow Designer:
? C. Provides natural-language descriptions of flow logic: This allows users without programming experience to understand and modify flows, making them more
accessible to a wider range of users.
? D. Supports No-Code application development: Flow Designer provides a visual interface and pre-built actions that allow users to automate processes without
writing code. This can significantly reduce development time and effort.
? A. Supports easy integration with 3rd party systems: Flow Designer integrates with a variety of 3rd party systems through the Integration Hub, making it easy to
connect your ServiceNow instance to external applications.
Flow Designer offers a low-code/no-code approach to building automation, simplifies complex logic with natural language descriptions, and integrates seamlessly
with external systems.
References:
? ServiceNow Product Documentation: Exploring Flow Designer - https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-
designer/concept/flow-designer.html
? ServiceNow Community: Flow Designer vs Workflow - https://www.servicenow.com/community/developer-forum/what-are-the-advantages-and-disadvantages-
between-flow-designer/m-p/1407094

NEW QUESTION 540
- (Topic 3)
What resource can you use to view details of the tables and configuration items (CIs) associated with a particular use case?

A. Scenario Dashboard
B. CI Use Case Modeler
C. CMDB Use Case Modeler
D. Common Service Data Model (CSDM) product view

Answer: D

Explanation: 
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html
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NEW QUESTION 545
- (Topic 3)
Which allows the creation of a task-based record from Service Catalog?

A. Record Producers
B. UI Builder
C. Assignment Rule
D. Flow Designer
E. UI Actions=

Answer: D

NEW QUESTION 547
- (Topic 3)
On a filter condition, which component is always a choice list?

A. Operator
B. Filter Criteria
C. Operation
D. Match Criteria

Answer: C

Explanation: 
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/common-ui-elements/concept/c_ConditionBuilder.html

NEW QUESTION 550
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to adjust the look of your report, including colors, files, and
legend layout?

A. Format
B. Layout
C. Style
D. Configure

Answer: C

NEW QUESTION 555
- (Topic 3)
On a filter condition, there is an element, which is based on the table, the user access rights, and columns on the table. What is this element called?

A. Attribute
B. Label
C. Field
D. Column
E. Data Element

Answer: C

NEW QUESTION 558
......
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